SUPPLEMENT:
CHARITIES & NONPROFITS
(990, 990-EZ, 990-N, 990-PF, 990-T)
Copyright

The 2018 Drake Tax Manual Supplement: Charities and Non-Profits, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2018 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

What’s New in Drake Tax for Charities and Non-Profits .............................................. 7  
IRS Changes for 2018 ........................................................................................................ 7  
Getting Started in the 990 Package .................................................................................. 9  
Creating a Return .............................................................................................................. 9  
Updating a Prior-Year Return .......................................................................................... 10  
Completing Schedules in Drake Tax ................................................................................ 10  
Form 990-N ...................................................................................................................... 12  
Form 990-EZ .................................................................................................................... 12  
Form 990-EZ Screens ...................................................................................................... 13  
Form 990-PF .................................................................................................................... 13  
Form 990-PF Screens ...................................................................................................... 13  
Recommended Order for Completing Form 990-P ......................................................... 14  
Form 990-T ...................................................................................................................... 16  
Form 990-T Screens ........................................................................................................ 16  
Form 990 .......................................................................................................................... 17  
Recommended Order for Completing Form 990 ........................................................... 17  
Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N) ................................. 19  
Schedule R ........................................................................................................................ 20  
Part VII, Section A .......................................................................................................... 20  
Parts VIII, IX, and X ....................................................................................................... 21  
Header Line G .................................................................................................................. 22  
Parts III, V, VII, and XI ................................................................................................... 22  
Schedule L, Transactions With Interested Persons ......................................................... 25  
Part VI, Governance, Management, and Disclosure ...................................................... 26  
Part I, Summary .............................................................................................................. 26  
Part IV, Checklist of Required Schedules ..................................................................... 26  
Schedules .......................................................................................................................... 26  
Part II, Signature Block .................................................................................................. 29  
Filing an Extension ........................................................................................................... 30  
Amending a Return ......................................................................................................... 30  
Credits Tab ....................................................................................................................... 31  
Form 3115, Application for Change in Accounting Method ............................................ 31  
Accessing Screens for Changing Accounting Method .................................................... 32  
Form 3115 Screens ......................................................................................................... 32  
Safe Harbor Elections ..................................................................................................... 33  
Binary Attachments ....................................................................................................... 34  
Printing Generated Documents ...................................................................................... 34  
Using the PRNT Screen .................................................................................................. 34  
Suppressing/Forcing Items ............................................................................................. 35  
Overriding Other Setup Options .................................................................................... 35  
Turn Off Autobalance ...................................................................................................... 36  
Electronic Filing ............................................................................................................... 36
Charities and Non-Profits (990)


WHAT’S NEW IN DRAKE TAX FOR CHARITIES AND NON-PROFITS

Drake Tax programs its software according to the latest IRS rules and regulations. The 2018 program reflects all IRS changes to forms, credits, and deductions. For specific details on the IRS’s changes, see the IRS instructions for individual forms for tax-exempt organizations.

IMPORTANT

Be sure to review the 2018 Drake Tax User’s Manual – available from the Support.DrakeSoftware.com website – for details on the changes to the tax program and practice management tools such Update Manager, Scheduler, Client Status Manager, new security measures, such as two-step authentication, and enhancements to other programs, such as SecureFilePro and Drake Accounting.

IRS CHANGES FOR 2018

Following are some changes to the 990 return and to Drake Tax’s 990 program. For details, see the IRS instructions.
Program Functionality

- Tax-exempt status will now be selected only once on screen 1. This information flows all other forms that require it. If filing only Form 990-T for either of the following sections – 401(a), 408(e), 408A, 530(a), 220(e), or 529(a) – mark the 990-T only check box and select the appropriate section from Exempt under section other than 501(c) drop list located on screen 1.

- Screen 8868, Application for Extension, has a check box for filling extension for Forms 990 (990-PF or 990-EZ), 990-T, and 4720.

Accounting Standards

- Form 990 has not been revised to reflect changes in the non-profit accounting standard, ASU 2016-14; however, this year’s instruction for Form 990 guide non-profit organizations that adopted ASU 2016-14 in how to report fund balances on the existing Form 990. For more information, see IRS instruction for Part X of Form 990 or, in the tax program, open screen 10B, available from the 990 only section of the General tab of the Data Entry Menu, and view the field help for either the “Unrestricted fund balance,” “Temporarily restricted fund balance,” or “Permanently restricted fund balance” fields. (Click in the field and press F1.)

- An organization other than 501(c)(3), 4947(a)(1) trust, or sec. 527 organization is no longer required to report the names and address of its contributors on Schedule B, Schedule of Contributors, attached to its Form 990 or Form 990-EZ for taxable years ending on r after December 31, 2018. This information, however, must be retained by the organization and presented to IRS upon request. Thus, the preparer should still enter this information on screen B, available from the Schedules A-G tab of the Data Entry Menu. As a result, the Schedule B generated in View/Print mode will not have names and address of the contributors, and a “Wks Schedule B” worksheet with Schedule B information that includes names and address of the contributors should be kept on record. See Rev. Proc. 2018-38 for more information about this revised filing requirement and help for a particular data entry within the tax program.

Changes Associated with Tax Reform

- The corporate tax rate is now a flat 21%. Trust tax rates changed.

- The Tax Computation Worksheet for Tax Exempt UBI supplemental worksheet (“Wks TTAX” in View/Print mode) for Form 990-T has been updated to reflect the changes in tax rates.

- For organizations that have employees, unrelated business taxable income (UBTI) reported on Form 990-T is increased by any amount for which a deduction is not allowable because of section 274 and which is paid or incurred by the organization after December 31, 2017, for any qualified transportation fringe (as defined in section 132(f)), or any parking facility used in connection with qualified parking (as defined in section 132(f)(5)(C), or any on-premises athletic facility (as defined in section 132(j)(4)(B)).

Excise Taxes

- Section 4960 imposes an excise tax on any organization that pays to any covered employee more than $1 million in remuneration or pays an excess parachute payment during the year starting in 2018. Screen OFF (Officers, Directors, Employees), was updated to automatically calculate the tax and answer corresponding questions on Form 990 and Form 990-PF. The tax will be calculated if there is either excess executive compensation or parachute payment, and either “Highest compensated employee” or “Former covered employee” is selected. For more
Excise Tax on Investment Income of Colleges and Universities:
- Section 4968 imposes an excise tax on the net investment income of certain private colleges and universities. Use screen SCO (Schedule O) available from the “Other Forms” tab of the Data Entry Menu, to complete tests found in Sec. 4968 to determine if the organization is subject to this excise tax. If the organization has already determined that it is subject to the tax, complete Form 4720, Schedule O information on screen SCO and screen SCOR for any related organization. The program automatically answers the related question of Form 990.

Foreign Transactions:
- All screens associated with foreign transactions are located on the Foreign tab of the Data Entry Menu.
- Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign Corporations, was updated to include changes in foreign provisions.
- Form 990-PF was updated with the new Sec. 951A reporting requirements. In addition, Form 5471 was updated and a new Form 8992, U.S. Shareholder Calculation of Global Intangible Low-Taxed Income, was added.

Getting Started in the 990 Package

Some early tasks you may need to perform before working on a 990 return include creating a return (for new clients) or updating a return (for existing clients).

NOTE

Use blank forms to help clients collect tax-related data you will need. To access blank forms, from the Home window, go to Tools > Blank Forms and select the Tax Exempt tab. Select a form from the list and click Print.

Creating a Return

To create a new return in Drake Tax:

1. From the Home window, click Open/Create (or select File > Open/Create Returns, or press CTRL+O).
2. In the Open/Create a New Return dialog box, enter the organization’s nine-digit identification number.
3. Click OK. Click Yes when asked if you want to create a new return.
4. In the New Return dialog box, select Tax Exempt - 990 and enter the organization’s name.
5. Click OK.

Screen 1 of the return is displayed. You can now begin entering header information for the organization.

NOTE

Header information for all forms is completed on screen 1. For information on specific fields in screen 1, see “Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)” on page 19.
UPDATING A PRIOR-YEAR RETURN

If you prepared the organization’s tax return last year, you must update it for use in 2018.

Prior-year returns can be updated in three ways:

- A single return (updated one at a time) using Last Year Data > Update Clients 2017 to 2018 (recommended)
- When you open an existing return from a prior year for the first time in the 2018 program and are prompted to update it
- With all other returns in the program using Last Year Data > Update Clients 2017 to 2018 (not recommended)

Drake Tax recommends using the first option (updating returns individually) to ensure that you update only those items in a return that you want updated.

NOTE If you open a prior-year 990 return that was marked as “Final Return” the previous year, the program informs you that the return was marked as final before it prompts you to proceed.

COMPLETING SCHEDULES IN DRAKE TAX

Many of the schedules used in Forms 990, 990EZ, and 990PF require a narrative summary explaining certain entries, selections, and elections made on specific lines in the return. The schedules requiring such summaries have their own Supplement Information screens for reporting these narrative summaries.

The Supplement Information screens can be accessed in several ways. For instance, screen O, used to provide narrative information for Schedule O, is available from either the Form 990/990EZ tab or Schedules H - R tab of the Data Entry Menu, or by typing the screen code O in the selector field of the Data Entry Menu and pressing ENTER.

The other schedules that require such supplemental information have screen links to the necessary supplemental screens. For instance, when completing Schedule D, there is a link on screen D (Figure 2-1 on page 10) to open the needed Schedule D - Supplemental Information screen.

![Schedule D - Supplemental Financial Statements](image)

Figure 2-1: Link to Schedule D - Supplemental Information screen from screen D

NOTE The SCH2 screen in a 990-PF return is the same as the O screen in the 990 and 990-EZ returns.
INFO Screen

Another way to access the Supplemental Information screens for the schedules is the INFO screen (figure below). Accessible from the Schedule H-R tab of the 990 Data Entry Menu, the INFO screen has links to Supplement Information drop lists of all of other individual schedules, allowing you to quickly find the attachment you need.

All of these Supplemental Information screens function is the same manner. To use one—in this example, the Supplemental Information screen for Schedule D—take these steps:

1. Either select Schedule D from the INFO screen, (figure at left) or open screen D and click the Schedule D Supplemental Info link (see Figure 2-2 on page 11).
2. From the Reference drop list, select the line numbers to be addressed. In the example on Figure 2-2 on page 11, the user has selected Escrow Account Liability in order to address Part IV, line 2b of Schedule D.
3. Under Explanation, type the narrative information. Note that there is a 9,000-character limit for e-file.
4. If necessary, press PAGE DOWN to open a blank screen and add supplemental information for another line of Schedule D.
5. If necessary, select item D99 - General Explanation Attachment, for non-line-specific general explanations.

Data entered on the Supplemental Information screen is printed in the supplemental information section of the specified schedule. For example, the narrative from Figure 2-2 on page 11 would be printed in the “Part XIII Supplemental Information” section on page 4 of Schedule D of Form 990.
**Form 990-N**

Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organizations.

To file the e-Postcard using Drake Tax, go to screen 1 for the organization and take the following steps:

1. Under the **General Information** heading, select **N - Form 990-N** from the **Form** drop list (item #1 in figure at right).
2. At the bottom of the **General Information** section, mark the **990-N Only** check box to indicate that the organization’s gross receipts are normally not more than $50,000 (item #2 in figure at right).
3. Go to the **OFF** screen **(Screen Code: OFF)** and complete the **Officer Name** and **Title** fields, enter an address (or select the **Use entity address** check box), and for at least one officer, select **Principal officer**.

Once any EF Messages have been eliminated, the 990-N information can be e-filed. A “Form 990-N Information” page (“Form 990-N” in View/Print mode) is generated with the return for informational and bookkeeping purposes.

**NOTE** For information on signing a return prior to e-file, see “Part II, Signature Block” on page 29.

**Form 990-EZ**

Certain organizations can file Form 990-EZ, Short Form Return of Organization Exempt From Income Tax, instead of Form 990. If an organization’s gross receipts (total amounts received from all sources during its annual accounting period) are less than $200,000 and total assets at year-end are less than $500,000, it can file Form 990-EZ instead.

On screen 1, select **E - Form 990-EZ** from the **Form** drop list in **General Information** section.
**FORM 990-EZ SCREENS**

The following screens are specifically provided for completing Form 990-EZ. They are grouped under the **990-EZ only** section of the **Form 990/990EZ** tab of the Data Entry Menu.

### Table 2-1: 990-EZ Screens Under Form 990/990EZ Tab

<table>
<thead>
<tr>
<th>Screen</th>
<th>Title/Section on Form 990-EZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Part I, Revenue and Expenses</td>
</tr>
<tr>
<td>22</td>
<td>Parts II and III, Balance Sheet/Accomplishments</td>
</tr>
<tr>
<td>23</td>
<td>Part V, Other Information, Page 1</td>
</tr>
<tr>
<td>24</td>
<td>Part VI, Section 501(c)(3) Only</td>
</tr>
<tr>
<td>O</td>
<td>Schedule O, Supplemental Information</td>
</tr>
<tr>
<td>SCH3</td>
<td>Other Items</td>
</tr>
<tr>
<td>SCH5</td>
<td>Part I, Line 5c</td>
</tr>
<tr>
<td>SC21</td>
<td>Unreported Activities</td>
</tr>
<tr>
<td>SC40</td>
<td>Part I, Grants and Similar Amounts Paid</td>
</tr>
<tr>
<td>SC42</td>
<td>Part II, Other Assets/Liabilities</td>
</tr>
</tbody>
</table>

**NOTE**

See “COMP Screen” on page 24 for information on adjusting the calculated number of highly paid individuals and contractors in Part VI of Form 990-EZ.

**FORM 990-PF**

Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 990-PF instructions for specific information on who must file this form.

**FORM 990-PF SCREENS**

The 990-PF–specific screens are located under the **Form 990PF** tab (Figure 2-3).
Several screens, such as screen 1, the DEPR, OFF, and IND screens, and certain schedule (SCH or SC) screens, can also be found elsewhere in the menu, as they apply for multiple forms and not just the 990-PF.

**RECOMMENDED ORDER FOR COMPLETING FORM 990-P**

The IRS recommends completing Form 990-PF in the following sequence (Table 2-2) to limit jumping from one part of the form to another.

<table>
<thead>
<tr>
<th>Seq.</th>
<th>Section</th>
<th>Screens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IV</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>I and II</td>
<td>52, 53, 54</td>
<td>For required schedules, see “Part I Additional Schedules” and “Part II Additional Schedules” (following).</td>
</tr>
<tr>
<td>3</td>
<td>Heading</td>
<td>1, 51</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>III</td>
<td>SCH3</td>
<td>Select item 5 or 6 from Line Number drop list and enter a description and amount.</td>
</tr>
<tr>
<td>5</td>
<td>VII-A</td>
<td>57</td>
<td>Use screen SC57 to create a schedule for controlled entities.</td>
</tr>
<tr>
<td>6</td>
<td>VIII</td>
<td>OFF</td>
<td>Use the IND screen to enter data for independent contractors.</td>
</tr>
<tr>
<td>7</td>
<td>IX-A through X</td>
<td>59</td>
<td>If an explanation is required for line 1e of Part X, use screen SC59, Reduction Explanation.</td>
</tr>
<tr>
<td>8</td>
<td>XII, lines 1–4</td>
<td>60</td>
<td>Line 4 is calculated automatically in Drake.</td>
</tr>
<tr>
<td>9</td>
<td>V and VI</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>XII, lines 5–6</td>
<td>n/a</td>
<td>Calculated automatically in Drake.</td>
</tr>
<tr>
<td>11</td>
<td>XI</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>XIII</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>VII-B</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>XIV – XVII</td>
<td>62–66</td>
<td></td>
</tr>
</tbody>
</table>

**NOTES**

More in-depth information on completing Form 990-PF is available from FAQ item K (“Recommended Order for Completing Form 990-PF”). Click the FAQ link on any tab of the Data Entry Menu. See “COMP Screen” on page 24 for information on adjusting the calculated number of highly paid individuals and contractors in Part VIII of Form 990-PF.
Part I Additional Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in Table 2-2 on page 14):

- Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.
- Line 10c (Gross profit or loss) — Use screen SCH7.
- Line 11 (Other income) — Use screen SC50 for subsidiary schedule.
- Line 19 (Depreciation) — Use screen DEPR for depreciation schedule. (The lines for Net Investment income and Adjusted net income on the DEPR screen are required for columns B and C of page 1 of Form 990-PF.)
- Line 23 (Other expenses) — Use screen DEPR for amortization schedule. (The lines for Net Investment income and Adjusted net income on the DEPR screen are required for columns B and C of page 1 of Form 990-PF).

More in-depth information on completing Form 990-PF is available from FAQ item K (“Recommended Order for Completing Form 990-PF”). Click the FAQ link on any tab of the Data Entry Menu. See “COMP Screen” on page 24 for information on adjusting the calculated number of highly paid individuals and contractors in Part VIII of Form 990-PF.

Part II Additional Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 in Table 2-2 on page 14):

- Line 7 (Other notes/loans receivable) — Use screen SC14 (This produces statement STM 135) and/or screen SCH3 (This produces statement STM 113).
- Lines 10a – 10c (Investments) — Use screen SC54.
- Line 11 (Investments – land, buildings...) — Use screen SC53 for subsidiary schedule (when required).
- Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.
- Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.
- Line 20 (Loans from officers, directors...) — Use screen SC55 (when required).
- Line 21 (Mortgages and other notes payable) — Use screen SC55.
- Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using Screen SCH2

Screen SCH2, General Explanation Attachment, allows you to attach explanations for certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached statement. To select a section of a form, choose an option from the Schedule drop list at the top of screen SCH2. Next, write an explanation in the Explanation field. Press PAGE DOWN as needed for additional attachments. Note that there is a 9,000-character limit for e-file.

The SCH2 screen can be used for other 990 return types. Note that screens O (for Schedule O, Supplemental Information) and SCH2 are the same. See “Schedule O, Supplemental Info.” on page 29 for more information.

If X - General explanation attachment is selected from the Schedule drop list, the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF).

NOTES

The SCH2 screen can be used for other 990 return types. Note that screens O (for Schedule O, Supplemental Information) and SCH2 are the same. See “Schedule O, Supplemental Info.” on page 29 for more information.

If X - General explanation attachment is selected from the Schedule drop list, the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF).
**PMT Screen**

Use the electronic payment screen (PMT) for payment on Form 990-PF, an amended 990-PF, or an extension of time to file (Form 8868) only. The PMT screen can be accessed from the lower right corner of the Form 990PF tab of the Data Entry Menu, or by typing screen code PMT in the selector field and pressing ENTER.

Screen Code: PMT

By default, the program indicates that the entire balance is to be electronically withdrawn on the return due date unless otherwise indicated using the Federal pmt amount and Requested pmt date override fields on screen PMT. If the return is e-filed on or before the due date for this type of return, the requested payment date cannot be later than the due date for this type of return. If the return is transmitted after the due date, the requested payment date cannot be later than the current date.

A Withdrawal Selection is required if the program is to direct tax authorities to electronically withdraw funds from the foundation’s account.

The name of the financial institution, the bank’s routing number (RTN), the client’s account number, and the type of account (checking or savings) are required. The RTN, account number, and type of account must be entered twice.

Finally, the PMT screen must indicate the return to which the payment data applies. Mark the box of the applicable return type (990PF, 8868, or Amended 990PF).

**Form 990-T**

Form 990-T, Exempt Organization Business Income Tax Return, is used for:

- Reporting unrelated business income and tax liability
- Reporting proxy tax liability
- Claiming a refund paid by either a regulated investment company (RIC) or a real estate investment trust (REIT) on undistributed long-term capital gain
- Requesting a credit for certain federal excise taxes that have been paid
- Claiming Form 8941 credit for small-employer health insurance premiums

Based on the items listed above, an organization may need to complete Form 990-T in addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

**Form 990-T Screens**

All 990-T–specific screens are located under the Form 990T tab (Figure 2-4).
FORM 990

A tax-exempt organization under section 501(a) must file Form 990 if it has either:

- Gross receipts of $200,000 or more
- Total assets of $500,000 or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions published by the IRS.

RECOMMENDED ORDER FOR COMPLETING FORM 990

The sequence shown in Table 2-3 is suggested as an efficient method for completing a return for a tax-exempt organization. In general, complete the core form first, and then complete—alphabetically—Schedules A through O and Schedule R, except as specified in Table 2-3 on page 18. This order limits the need to jump back and forth from one part of the form to another, as certain later parts are required in order to complete earlier parts.

TIP

More details are available in FAQ item E (“Recommended Order for Completing Form 990”). Click the FAQ link on any tab of the Data Entry Menu.

NOTE

Screen 80 must include a selection for item G (organization type) in order for Form 990-T to be produced correctly with the appropriate tax calculated.
**Table 2-3: Form 990, Recommended Order**

<table>
<thead>
<tr>
<th>Seq.</th>
<th>Section</th>
<th>Screens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A – F; H(a) – M (heading)</td>
<td>1 and OFF</td>
<td>This is the “Heading” section of Form 990; item F is completed on screen OFF; item M is completed automatically based on resident state entered.</td>
</tr>
<tr>
<td>2</td>
<td>Schedule R</td>
<td>R, R2, R3</td>
<td>Determine related organizations, disregarded entities, and joint ventures for which reporting will be required. (See Sch. R instructions; Form 990 instructions, Appendix F, Disregarded Entities and Joint Ventures).</td>
</tr>
<tr>
<td>3</td>
<td>Part VII, Section A</td>
<td>OFF</td>
<td>Officers, directors, trustees, key employees, and five highest-compensated employees. To adjust the number of individuals receiving more than $100,000, use the COMP screen.</td>
</tr>
<tr>
<td>4</td>
<td>Part VIII, IX, and X</td>
<td>8, 9, and 10</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Header line G</td>
<td>1</td>
<td>Completed automatically in Drake Tax.</td>
</tr>
<tr>
<td>6</td>
<td>Parts III, V, VII, XI, and XII</td>
<td>3, 4, 6, IND, 11</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Schedule L</td>
<td>L</td>
<td>Complete if required; see Schedule L instructions.</td>
</tr>
<tr>
<td>8</td>
<td>VI</td>
<td>7</td>
<td>Transactions reported on Schedule L are relevant to determine independence of members of the governing body under Form 990, Part VI, line 1b.</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>2</td>
<td>Complete based on information derived from other parts of the form.</td>
</tr>
<tr>
<td>10</td>
<td>IV</td>
<td>5</td>
<td>Complete this section to determine which schedules must be completed.</td>
</tr>
<tr>
<td>11</td>
<td>Schedule O and any other applicable schedules</td>
<td>Schedules A – G and Schedules H – R tabs</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>II</td>
<td>PIN; Setup info</td>
<td>See “Part II, Signature Block” on page 29.</td>
</tr>
</tbody>
</table>
**HEADER INFORMATION (FORMS 990, 990-EZ, 990-PF, 990-T, 990-N)**

Use screen 1 to complete the header section for a tax-exempt organization. Complete all applicable fields.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header information to be completed first are items A through F and H(a) through M. Item A is completed only fiscal-year returns. Item F is completed on the Officer (OFF) screen, The “Gross receipts” line on page 1 (header item G) on Form 990 is completed automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Foreign Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the organization has a foreign address, fill out the applicable fields in the <strong>Foreign ONLY</strong> section of screen 1.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreign address fields are locked to keep incorrect address data from being entered. Click the field to unlock foreign address fields throughout the return. Close the return and re-open it to re-engage the lock for unused screens.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type of Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>To indicate which form the organization is filing, select an option from the <strong>Form</strong> drop list in the <strong>General Information</strong> section of screen 1. (See Figure 1 on page 12 and Figure .) If the only return being prepared is a 990-T and its related forms, mark the <strong>990-T only</strong> box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Form Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen 1 has separate columns indicating the header boxes for Forms 990, 990-EZ, and 990-PF. For example, the “Exemption application pending” check box on screen 1 (item #1 in figure at right) puts an “X” in box “B” of Forms 990 and 990-EZ, or an “X” in box “C” of Form 990-PF. Note that not all questions are required for all forms.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Affiliate Listing (990 Only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the 990 is a group return filed for affiliates, but not all affiliates are included, a list of affiliates must be attached to the return. Screen <strong>SCH4</strong> is available for this purpose and includes fields for affiliate name, address, and EIN. Click the <strong>SCH4</strong> link on screen 1 (item #2 in figure above right).</td>
</tr>
</tbody>
</table>
Tax Year
The program uses the current calendar tax year (beginning January 1 and ending December 31) by default. If the organization uses a fiscal year, enter the beginning and end dates in the **If not calendar year** box on screen 1 (Figure 2-5).

![Figure 2-5: If not calendar year box on screen 1](image)

SCHEDULE R

Once you have completed the header information on screen 1, the IRS recommends completing Schedule R, Related Organizations and Unrelated Partnerships. Schedule R is used to submit data regarding the organization’s relationships with other organizations, both taxable and tax-exempt. The program has three screens (located on the Schedule H-R tab of the Data Entry Menu) for Schedule R, listed in Table 2-4.

<table>
<thead>
<tr>
<th>Screen</th>
<th>Sections of Schedule R Covered</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organizations), and III (Related Organizations Taxable as a Partnership)</td>
</tr>
<tr>
<td>R2</td>
<td>Schedule R, Parts IV (Related Organizations Taxable as a Corporation or Trust), V (Transactions With Related Organizations), and VI (Unrelated Organizations Taxable as a Partnership)</td>
</tr>
<tr>
<td>R3</td>
<td>Schedule R, Part V, Line 1 (Related Organizations and Unrelated Partnerships)</td>
</tr>
</tbody>
</table>

To enter more entities, press PAGE DOWN to access new, blank fields.

NOTE
Schedule R is not required for all organizations. For information on which aspects of Schedule R must be completed by an organization, see the IRS instructions for Schedule R, or see the Screen Help on screens R, R2, and R3. (Click the Help icon on the screen toolbar or press CTRL+ALT+?.)

PART VII, SECTION A

Screen code: **OFF**

Once you have completed Schedule R, the IRS recommends completing Part VII, Section A (“Compensation of Officers, Directors, Trustees, Key Employees, Highest Compensated Employees, and Independent Contractors”). Use the **OFF** screen, accessible from the Form990/990EZ tab of the Data Entry Menu, to report this informa-
tion, noting that information entered there is used to generate Part II of Schedule J (“Compensation Information”).

**NOTE** See “COMP Screen” on page 24 for information on adjusting the calculated amount in Part VII, Section A of Forms 990 and 990-EZ.

**PARTS VIII, IX, AND X**

Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting purposes. These sections are accessed from screens 8, 9A, 9B, 10A, and 10B, accessed from the 990 Only section of the Form990/990EZ tab of the Data Entry Menu. (Figure 2-6)

![Figure 2-6: Parts VIII, IX, and X are completed on screens 8, 9, 9B, 10A, and 10B](image)

**Statement of Revenue**

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to complete items 1 and 3 through 10. Press PAGE DOWN (or click the Lines 2 and 11 link) to access fields for items 2 (“Program Service Revenue”) and 11 (“Miscellaneous Revenue”).

**Statement of Functional Expenses**

Use the organization’s normal accounting method to complete Part IX, Statement of Functional Expenses. Part IX should not be used to report expenses that belong on lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

Part IX has two screens; to access the first screen (lines 1 through 14), go to screen 9A. To access the second screen (lines 15 through 26), press PAGE DOWN from screen 9A or go to screen 9B.
Balance Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used. Part X has two screens: screen 10A (lines 1 through 15), and 10B (lines 17 through 32). You can access screen 10B from screen 10A by pressing PAGE DOWN.

NOTE

Some end-of-year amounts require separate schedules. Screens for these schedules can be accessed by clicking the applicable links on screens 10A, 10B, and 11.

HEADER LINE G

The program calculates box “G” (gross receipts) of the form header automatically, based on the information entered on screen 8, (including the linked Line 2 and 11 screen).

PARTS III, V, VII, AND XI

Once you have completed screen 8 (both screens) for box “G” of the header, the IRS recommends completing Parts III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, and 11).

Purpose & Achievement

Part III, Statement of Program Service Accomplishments, requires that the organization report its new, ongoing, and discontinued exempt purpose achievements, along with any related revenue and expenses.

In Drake Tax, Part III of Form 990 consists of two screens. Use screen 3 to answer items 1 through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt purpose achievements). From screen 3, you can access screen 4 by pressing PAGE DOWN.

Exempt Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s mission. The mission statement can address why the organization exists, what it hopes to accomplish, whom it intends to serve, and activities it will undertake and where. See IRS instructions for further information on what constitutes a mission.

NOTE

If the organization does not have a mission that has been adopted by its governing body, type None as the Primary exempt purpose.

If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to describe any new services or changes to services. From screen 3, you can click the
Sch O Screen link to access the Supplemental Information screen. From the Schedule drop list of the Supplemental Information screen, select O22 (for line 2) or O23 (for line 3).

See “Schedule O, Supplemental Info.” on page 29 for more information about filling out Schedule O in the program.

Enter expenses, revenue, and a description of the exempt purpose achievements on screen 4. Examples of exempt achievements include:

- Providing charity care under a hospital’s charity care policy
- Providing higher education to students under a college’s degree program (the number of students served must be indicated)
- Making grants or providing assistance to individuals who were victims of a natural disaster
- Providing rehabilitation services to residents of a long-term care facility

**NOTE** The Program service code drop list on line 4 of screen 4 is not used.

Acceptable exempt achievements do not include any achievement not substantially related to the accomplishment of the organization’s exempt purpose (other than by raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, press PAGE DOWN and continue the description. There is no need to re-enter the information in the top section of the screen. If the description takes up more space than is allowed on the printed return, the program generate sit on a separate page in View mode, the SERVICES page (Figure 2-7).

To enter another achievement, press PAGE DOWN and mark the box labeled Mark this box if starting a new description. The second description entered is shown (or referenced on a SERVICES page, if applicable (Figure 2-7) in section 4b of Part III. A
third description is printed or referenced in section 4c. Additional descriptions are shown on additional SERVICES pages generated with the return.

**NOTE**

The exempt achievement description has a 9,000–character limit for e-file; if the description exceeds 9,000 characters, the return must be paper-filed.

### Other IRS Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show the organization’s compliance with the requirements of other federal tax laws for reporting and substantiation. Use screen 6 in the program to enter data for Part V. In Drake Tax, Part V consists of two screens: use screen 6 to answer items 1 through 6b; press PAGE DOWN from screen 6 to access items 7 through 14b.

### Compensation

Part VII reports compensation paid to officers, directors, trustees, key employees, highest-compensated employees, and independent contractors. For Form 990, 990-EZ, or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent contractors) to enter this information.

The OFF screen also has fields for entering an officer’s address, “books in care of” selection, and an indication of whether the specified officer signs the return or takes care of the organization’s books. The IND screens has fields for the name and address, type of service, and compensation of five contractors. (Press PAGE DOWN for the second screen.)

### COMP Screen

Use the COMP screen (Figure 2-8) to adjust the number of highly paid individuals—such as officers, contractors, directors, trustees, key employees—on 990, 990EZ, and 990 PF returns.

The COMP screen is accessible from the Form 990/990EZ tab or from the 990PF tab of the Data Entry Menu.

![Figure 2-8: COMP screen for High-Paid Individuals](image)
Use the COMP screen:

- To adjust the number of individuals who received more than $100,000 (990 returns). The number entered in Section A field of the COMP screen adjusts the number entered on the OFF screen.
- To adjust the number of contractors who received more than $100,000 (990 returns). The number entered in the Section B field of the COMP screen adjusts the number entered on the IND screen.
- To adjust the number of employees (excluding officers, directors, trustees, or key employees) who received more than $100,000 (990-EZ returns). The number entered on line 50 of the 990-EZ Only section of the COMP screen adjusts the number entered on the OFF screen.
- To adjust the number of contractors (excluding the five highest compensated entered on the IND screen) who received more than $100,000 (990-EZ returns). The number entered on line 51 of the 990-EZ Only section of the COMP screen adjusts the number entered on the IND screen.
- To adjust the number of individuals (excluding the officers, directors, trustees, and key, employees listed on the OFF screen) who received more than or more than $50,000 (990-PF returns). The number entered on line 2 of the 990-PF Only section of the COMP screen adjusts the entries on the OFF screen.
- To adjust the number of contractors (excluding the five highest compensated entered on the IND screen) who received more than $50,000 (990-PF returns). The number entered on line 3 of the 990-PF Only section of the COMP screen adjusts the entries on the IND screen.

**Reconciling Net Assets**

Enter the amount of changes in net assets or fund balances that occurred during the tax year on line 9 line of screen 11. These would include items such as prior-period adjustments and changes in accruals.

Explain the changes on screen O, selecting code O26 in the Schedule drop list.

**Financial Statements & Reporting**

Part XII, Financial Statements and Reporting, is used for reporting information on the organization’s accounting methods and financial statements. The accounting method (line 1 of Part XII) reflects the method indicated on screen 1. Use screen 11 to answer all other items for Part XII.

**Schedule L, Transactions With Interested Persons**

Screen L (available on the Schedules H-R tab of the Data Entry Menu) contains fields for completing Parts I through IV of Schedule L, Transactions With Interested Persons. All or part of Schedule L may be required for certain organizations that file Forms 990 or 990-EZ. Schedule L is used for the following purposes:

- Reporting information on certain financial transactions or arrangements between the organization and disqualified persons under section 4958 or other interested persons
- Determining whether a member of an organization’s governing body is an independent member for purposes of Form 990, Part VI, line 1b (“Enter the number of voting members who are independent”)
For information on which organizations must complete all or part of Schedule L, see Screen Help on the screen L (from the data entry screen toolbar, click Help, right-click the screen and choose Screen Help, or press CTRL+ALT+?) or consult the IRS instructions.

**PART VI, GOVERNANCE, MANAGEMENT, AND DISCLOSURE**

Part VI, Governance, Management, and Disclosure, requests information regarding the governing body and management governance policies and disclosure practices. Although federal tax law generally does not mandate particular management structures, operational policies, or administrative practices, every organization is required to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access Sections B and C. If additional information is required for Part VI, use Schedule O (screen O; see “Schedule O, Supplemental Info.” on page 29). O Screen links are available on parts of screen 7.

**PART I, SUMMARY**

The summary section of Form 990 is for information regarding the mission, activities, and financial results of the organization. Use screen 2 to complete Form 990 Part I, Summary. (Line 1 of the “Summary” section of Part I flows from screen 3, line 1, Primary exempt purpose.)

**Number of Volunteers**

Enter the number of full-time and part-time volunteers who provided volunteer services to the organization during the reporting year. A reasonable estimate is acceptable if an exact number is not known. If the organization wishes to provide an explanation of how the number was determined, use Schedule O (screen O in the program; see “Schedule O, Supplemental Info.” on page 29).

**Line 7b**

If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.

**Lines 8–17**

Prior-year amounts are updated automatically from the previous year’s return. These amounts can be entered or edited on screen 2.

**PART IV, CHECKLIST OF REQUIRED SCHEDULES**

An organization uses Part IV, Checklist of Required Schedules, to determine which schedules must be completed and filed with the tax return. In Drake Tax, two screens contain fields for Part IV. Open screen 5 to access “Yes” and “No” check boxes for lines 3 through 24d. Press PAGE DOWN from screen 5 to answer questions 25a through 37. Links gives you access to other appropriate screens. (See Figure 2-9 on page 27.)

**SCHEDULES**

Use the Schedules A – G and Schedules H – R tabs of the Data Entry Menu to access schedules. Specific schedules can also be accessed using links within certain screens, such as screen 5 (Figure 2-9 on page 27).
Schedule A, Public Charity Status and Public Support, provides information regarding public charity status and public support on Form 990 or Form 990-EZ.

Use the following screens to enter data for Schedule A:

- Screen A (Part I, Reason for Public Charity Status; required by all organizations filling out Schedule A.)
- Screen A2 (Part I, Line 12, Information about Supported Organizations)
- Screen A3 (Parts II and III, Support Schedules)
- Screen A4 (Part VI, Supporting Organizations)
- Screen A5 (Part V, Type III Non-Functionally Integrated 509(a)(3) Supporting Organizations)

Schedule A is required. At a minimum, amounts must be entered for the current year—even if the amounts are zero (“0”). If there are no entries for Schedule A, an EF Message is generated upon calculation, and the return cannot be e-filed.

Field- and screen-level help resources within the program provide valuable supplemental information and tips for completing Schedule A in Drake Tax. Press F1 for field-level help. On screens A and A3, access Screen Help by clicking Help from the data entry screen toolbar, by pressing Ctrl+Alt+? from your keyboard, or by right-clicking the screen and choosing Screen Help from the right-click menu.

Screen A4 consists of two screens. From the first screen, press PAGE DOWN to access Sections B through E on the second screen.
Message is generated and the return cannot be e-filed. In Drake Tax, use screen B to enter Schedule B information.

**NOTES**

Contributor information on Schedule B is not publicly disclosed.

If Schedule B is not required, open screen 1 and mark the check box on line IV on the lower left side of the screen.

**Schedule C, Political & Lobbying**

Schedule C is required for certain section 501(c) organizations and section 527 organizations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

- **Screen C** — Parts I-A, I-B, and I-C
- **Screen C1** — Part I-C, line 5 (names, addresses, and EINs of section 527 organizations to which payments were made)
- **Screen C2** — Parts II-A and II-B
- **Screen C3** — Parts III-A and III-B

See the IRS form instructions for who is required to file.

**Schedule D, Financial Statements**

Filers of Form 990 should use Schedule D to provide the required reporting for the categories listed in Table 2-5. This table also shows which screens in Drake Tax are available for completing specific information.

<table>
<thead>
<tr>
<th>Category</th>
<th>Section of Schedule D</th>
<th>Screen to Use in Drake Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Donor-advised funds (DAFs)</td>
<td>Part I</td>
<td>D</td>
</tr>
<tr>
<td>Conservation easements</td>
<td>Part II</td>
<td>D</td>
</tr>
<tr>
<td>Certain art and museum collections</td>
<td>Part III</td>
<td>D2</td>
</tr>
<tr>
<td>Escrow accounts and custodial arrangements</td>
<td>Part IV</td>
<td>D2</td>
</tr>
<tr>
<td>Endowment funds</td>
<td>Part V</td>
<td>D3</td>
</tr>
<tr>
<td>Investments - Land, Buildings, Equipment</td>
<td>Part VI</td>
<td>D3</td>
</tr>
<tr>
<td>Investments - Land, Buildings, Equipment</td>
<td>Part VI, line 1e</td>
<td>D1E</td>
</tr>
<tr>
<td>(&quot;Other&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supplemental financial information</td>
<td>Parts VII through X</td>
<td>D4</td>
</tr>
<tr>
<td>Supplemental financial statements</td>
<td>Parts XI through XII</td>
<td>D5</td>
</tr>
</tbody>
</table>

Press PAGE DOWN to go to the next Schedule D screen.

**NOTE**

Note that Part VI, line 1e (“Other”) requires a separate screen from the previous Part VI information. Click the Line 1e detail link on screen D3 or press PAGE DOWN to open screen D1E.

To enter data for Parts VII through X, go to screen D4 and select the applicable part from the Part drop list (Figure 2-10 on page 29).
Figure 2-10: Select the applicable part on screen **D4** for parts VII through X.

Press **PAGE DOWN** to access a blank **D4** screen and enter data for additional parts.

For information on completing Part XIII of Schedule D, see the “Schedule O, Supplemental Info.” section, following.

**Schedule O, Supplemental Info.**

The IRS provides Schedule O for filers who must include narrative information for specific lines. Use screen **O** to provide narrative information for Schedule O.

Screen **O** functions like the other “supplemental information” screens. For details, see “INFO Screen” on page 11.

All Form 990 or 990-EZ filers must file Schedule O. Certain questions require all filers to provide an explanation in Schedule O. In general, answers can be explained or supplemented on screen **O**, using the **Schedule** drop list and **Explanation** text box.

To add a narrative explanation for an amended return, select **AMD**. See “Amending a Return” on page 30 for more on amending a return.

To add a general explanation attachment, select **X** (located at the bottom of the drop list).

**Z Items**

Items beginning with “Z” in the **Schedule** drop list on screen **O** flow to Schedule O of Form 990-EZ.

**PART II, SIGNATURE BLOCK**

The signature block on Form 990 contains fields for up to two signatures:

- An officer of the organization
- The paid preparer (if applicable)

To e-file a return, enter the paid preparer’s and organization officer’s PINs on the **PIN** screen.

**IMPORTANT**

The applicable ERO or preparer PIN must be entered in **Setup > Preparer(s)** or **Setup > Firm(s)** in order to e-file a tax return. For more information on setting up firm, preparer, and ERO information in Drake Tax, see Chapter 2 of the 2018 **Drake Tax User’s Manual**.

---

**NOTES**

All Form 990 or 990-EZ filers must file Schedule O. Certain questions require all filers to provide an explanation in Schedule O. In general, answers can be explained or supplemented on screen **O**, using the **Schedule** drop list and **Explanation** text box.

To add a narrative explanation for an amended return, select **AMD**. See “Amending a Return” on page 30 for more on amending a return.

To add a general explanation attachment, select **X** (located at the bottom of the drop list).
Filing an Extension

Note about Preparer ID

Generally, anyone who is paid to prepare a return must sign the return and complete the other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of a filing organization is not a paid preparer.

Filing an Extension

Calender-year returns are due on May 15, 2019. If an organization uses a fiscal year, the return is due by the fifteenth day of the fifth month after the accounting period ends. By filing Form 8868, an organization can extend the deadline six months (to November 15 for a calendar-year return).

Use the 8868 screen (available from the Other Forms tab) to apply for an automatic sixth-month extension. (Figure 2-11).

![Application for Extension of Time To File an Exempt Organization Return](image)

Figure 2-11: Mark the check box on screen 8868 to apply for an extension

**Note**

Form 8868, Application for Additional Extension of Time to File an Exempt Organization return can be e-filed.

Amending a Return

Indicate an amended return in the General Information section of screen 1. Note that an explanation is required on screen O for an amended return.

When you amend a return in Drake Tax, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6 of the 2018 Drake Tax User’s Manual.

To provide an explanation for an amended return:

1. Open screen O.
2. From the Schedule drop list, select AMD - Amended return information (Figure 2-12 on page 31).
3. Enter the explanation in the text box below the drop list. Character limit for e-file is 9,000 characters.

**IMPORTANT** The amended return should include all information pertaining to the return—not just the new or corrected data.

**CREDITS TAB**

- **General Business Credits**
  
  Use screen **3800** to claim current-year business credits that are not supported by Drake Tax. (Supported credits are listed on the right side of the **Credits** tab.)

  Use screen **GBC** for reporting general business credit (GBC) and eligible small business credit (ESBC) carrybacks and carryforwards, and to enter passive activity credit carryforwards.

  For tax-exempt entities, use the **CRED** screen if you want to enter current-year pass-through credits from pass-through entities (optional).

  For details on using the **3800** and **GBC** screens, go to “General Business Credits” in Chapter 5 of *2018 Drake Tax User’s Manual*.

  Screens for computing foreign tax credits are listed on the left side of the **Credits** tab.

**FORM 3115, APPLICATION FOR CHANGE IN ACCOUNTING METHOD**

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any material item.

Form 3115 is eligible for e-file.

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and attachments for 990 returns.
In some cases, Form 3115 must still be paper-filed.
Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.

### Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible from the Change in Accounting Method box, located under the Other Forms tab of the Data Entry Menu (Figure 2-13).

![Figure 2-13: Screens for Form 3115, Application for Change in Accounting Method](image)

The screens accessible from the Change in Accounting Method section include:

- **Screen 3115 (Change in Accounting Method)** — Used to access fields for Form 3115, including Schedules A through D
- **Screen 311E (Schedule E)** — Used to request a change in depreciation or amortization methods
- **Screen ATT (Explanations and Attachments)** — Used to create and view certain attachments to be generated by the software
- **Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment)** — Used to complete certain parts of Form 3115 that require specific attachments

### Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the first of six 3115 screens. As shown in Figure 2-14 on page 33, you can access these 3115 screens by clicking a link at the top of any other 3115 screen.
Multi-form Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 2-14) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake Tax. The first should be “1,” the second “2,” and so on. When using other screens, such as the 311E or ATT screens, you can use those numbers to indicate which instance of Form 3115 the 311E or ATT screen should be associated with.

NOTE

If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

Notices of Missing Attachments

In addition to Form 3115 and related schedules and statements, the program produces EF Messages (as applicable) when the return is calculated. All forms, schedules, EF Messages, and worksheets are accessible from View mode.

EF Messages for Form 3115 provide information about required attachments (including PDF attachments) that are missing from the return. Some messages list all statements required for a particular section but do not indicate which statements, specifically, are missing. To best understand which attachments are still required, compare the ATT screen and the statements (such as “Statement 465” and Statement 2-15” in View/Print mode) to the list of missing statements and schedules in the EF Messages.

NOTE

All EF Messages must be eliminated before the return is eligible for e-file. EF Messages for Form 3115 attachments are eliminated when all required statements have been attached to the return.

SAFE HARBOR ELECTIONS

Use the Building qualifies for Section 1.263... check box on screen DEPR to apply a small taxpayer Safe Harbor election to a building listed in the Description field. An
This Safe Harbor election covers buildings only.

This Sec. 1.263(a) - 3(n) Election can also be made from the Elections drop list on the ELEC screen (available on the Miscellaneous tab), as can a Sec. 1.263(a) - 1(f) de minimis safe harbor election.


**Binary Attachments**

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a document must be in PDF format and attached to the return in order to be e-filed with it. Paper documents must be scanned into the computer to be attached.

*Screen code: PDF*

Attach files through the PDF Attachments screen, accessible from the Electronic Filing section on the General tab of the Data Entry Menu.

**Note** Directions for attaching documents can also be found in the Screen Help of the PDF Attachments screen, and in item L of the FAQ screen.

For details on attaching documents to a return, see “Binary Attachments” in Chapter 5 of 2018 Drake Tax User’s Manual.

**Printing Generated Documents**

In some instances, Drake Tax generates a document that must be printed, signed, and scanned back into the computer to be attached to the return. An EF Message will state that attachments are required. You will then need to obtain and complete the statements, scan them into the computer, save them as a PDF file, and attach them to the return.

**Using the PRNT Screen**

Use the PRNT screen (accessible from the Form 990/990EZ or Miscellaneous tabs) to override some program defaults.
SUPPRESSING/FORCING ITEMS

To suppress or force printing of certain items, go to the PRNT screen and select the desired options. Selections override the options established in Setup. For more on setting up options globally in Drake Tax, see Chapter 2 of the 2018 Drake Tax User’s Manual.

The following items can be “forced” from the PRNT screen (see Figure 2-15):

- Diagnostic summary report listing the forms calculated and providing a brief summary of the return
- Next-year depreciation listing for the organization
- Indication on the return that the organization has changed its accounting period
- Preparer’s name in the “Preparer’s signature” line for preparer and client copies of a return that has been e-filed

![Figure 2-15: PRNT screen options](image)

The following items can be suppressed from the PRNT screen of a 990 return (Figure 2-15):

- Commas (in the amounts printed on the forms)
- Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) or 501(c)(4) organization (Only Column A, “Total expenses,” would be generated for this section of Form 990.)
- Data for non-required fields on Form 990-T of gross receipts is $10,000 or less
- Proformas for next tax year

OVERRIDING OTHER SETUP OPTIONS

Filing instructions (federal and state) and envelope coversheets (organization, IRS, and state) can be either forced or suppressed from the PRNT screen to override the global setting in Setup > Options.

NOTE

A default due date for filing is printed on all letters and filing instructions generated with a return. You can override the default date by entering an alternate due date in the Due date to print on letter and filing inst field on the PRNT screen.
You can also enter the date to be printed on the return. In Setup > Options, Optional Items on Return tab, you can indicate if the return should have no date or if it should have the current system date. Use the PRNT screen to override the setup option choice for a return.

**TURN OFF AUTOBALANCE**

Autobalance forces the balance sheet to balance for both the beginning- and end-of-year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect data entry could cause these differences but they are usually the result of amounts being erroneously deleted or changed from the balance sheet screens. To reconcile the differences, it is best to compare the organization’s beginning and ending balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

**ELECTRONIC FILING**

An organization has the option to e-file Form 990, 990-EZ, 990-PF, 990-N, and related forms, schedules, and attachments. If the organization files at least 250 returns of any type during the calendar year and has total assets of $10 million or more at the end of the tax year, it is **required** to e-file Form 990.

### NOTE

- A short period return cannot be e-filed unless it is an initial return or a final return (one of those boxes is marked on screen 1.)
- Form 990-T cannot be e-filed.

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed instructions on e-filing returns in Drake Tax, see *2018 Drake Tax User’s Manual*.

To determine if an organization meets the $10 million asset test, use the amount of total assets at the end of the year (Form 990, page 11, line 16).

If an organization is required to e-file but does not do so, it is considered **not** to have filed its return. See Temporary Regulations section 301.6033-4T for more information.

For additional information on the e-file requirement, visit the IRS website at [www.irs.gov](http://www.irs.gov). Click the Charities & Nonprofits tab.

**IRS ERROR REJECT CODES**

If any of the following IRS error reject codes is generated when e-filing a 990 return, the preparer must contact the IRS for further information. The IRS e-Help Desk telephone number is (866) 255-0654

**F990-902-01**: The EIN in the return must have been established as an exempt organization return filer in the e-file database.
OTHER AVAILABLE FORMS

Use Drake Tax to complete these other returns.

FORM 8976, NOTICE OF INTENT TO OPERATE UNDER SECTION 501(C)(4)

Use the links on screen 8976, Online Registration System (Figure 2-16) to connect to the IRS website and file Form 8976, Notice of Intent to Operate Under Section 501(c)(4) tax-exempt organizations.

Most organizations must submit this notice within 60 days of their establishment. Failure to file this notice may result in penalties. This form can be filed only through the IRS website.

There is also a link on screen 8976 to connect you to the IRS Revenue Procedure that explains the form.

The 8976 screen is accessible from the Other Forms tab of the 990 Data Entry Menu.

FOREIGN TAB

In the Foreign Accounts and Assets section of the Foreign tab are screens FRGN and 114, used to complete and file FinCEN Report 114, Report of Foreign Bank and Financial Accounts, or Form 8938, Statement of Specified Foreign Financial Assets. Screen 8938 is also used in completing Form 8938.

Use the screens in the Information Return Foreign Corporations section to complete Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign Corporations.

F990-913-01: Tax-exempt status specified in Item I, must match data in the e-file database.

F990-913-01: The “Return Type” indicated in the return header must match the return type established with the IRS for this EIN.

R0000-922-01: Filer’s EIN and Name Control in the Return Header must match data in the e-file database, unless “Name Change” or “Name or Address Change” check box is marked, if applicable.
For more on completing and filing FinCEN Form 114, Form 8938, and Form 5471 in Drake Tax, see Chapter 5 of the 2018 Drake Tax User’s Manual.
Index

A
accomplishments, statement of 22
accounting method
   changing 32–33
accounting method used 25
address
   "books in care of" 24
   foreign 19
   of 527 organization 28
   of affiliates 19
adjustments to balance sheet 36
affiliates 19
amending a return 30
attachments
   from within data entry 15
   general explanation 15
   PDF 34
   to Form 3115 31
   auto-balance 36
diagnostic summary, printing a 35

E
e-filing
   and PIN signatures 29
   Form 990-N (e-Postcard) 12
   Form 990-T (not e-fileable) 16
   PDF files 34
   process 36
Elections
   Safe Harbor 33
e-Postcards (Form 990-N) 12
error reject codes 36
exempt
   achievement 23
   purpose 22
expenses, statement of 21
extension, filing an 30

F
filing
   an extension 30
   instructions (options for) 35
final returns 10
financial statements
   and reporting (Form 990, Part XI) 25
   on Schedule D (Form 990) 28
FinCen Report 114 37
fiscal year, indicating a 20
foreign accounts 37
foreign addresses 19
Form 3115 (Application for Change in Accounting Method) 31–33
Form 8868, Application for Extension 30
Form 8938, Statement of Specified Foreign Financial Assets 37
Form 8976, Notice of Intent to Operate Under Section 501(c)(4) 37
Form 990, Return of Org. Exempt from Income Tax 17–30
Form 990-EZ (short-form return) 12–13
Form 990-N (e-Postcard) 12
Form 990-PF (private foundations) 13–15
Form 990-T (business income returns) 16–17
form type, selecting a 19
functional expenses 21

B
balance sheet
   adjustments to 36
   screens 22
blank forms 9
books in care of 24
business income returns (Form 990-T) 16

C
Change in Accounting Method 31–33
charity care for hospital 23
checklist of required schedules 26
codes
   multi-form 33
commas, suppressing 35
COMP screen 24
compensation of officers, etc. 20, 24
contributors (Schedule B) 27
coversheets, options for 35
creating a new return 9
credit for excise taxes 16

D
date (to print on return) 36
depreciation listing 35
Index

G
  governance, management, & disclosure 26
gross receipts 22

H
  header information 9, 19
  higher education, provision of 23

I
  INFO screen 11

L
  lobbying activities (Schedule C) 28
  long-term care services, provision of 23

N
  Name Control field (screen 1) 19
  narrative information, providing 29
  natural disaster assistance 23
  next-year depreciation listing 35

O
  officer compensation 20, 24
  order for completing
    Form 990 17
    Form 990-PF 14
  other IRS filings and tax compliance 24
  override
    of setup options 35

P
  partnerships, unrelated (Schedule R) 20
  PDF files, e-filing 34
  PIN signatures 29
  political campaigns (Schedule C) 28
  preparer signature 29
  primary exempt purpose 22
  prior-year returns, updating 10
  private foundation return (Form 990-PF) 13–15
  proxy tax liability 16
  public status & support (Schedule A) 27

R
  real estate investment trusts (REITs) 16
  receipts, gross 22
  regulated investment companies (RICs) 16
  rehabilitation services 23
  reject codes 36
  related organizations (Schedule R) 20
  required schedules, checklist of 26
  returns
    creating 9
    updating from the prior year 10
  revenue, statement of 21

S
  Safe Harbor Elections 33
  SCH2 (attachment) screen 15
  Schedule A (Public Status and Support) 27
  Schedule B (Schedule of Contributors) 27
  Schedule C (Political Campaign and Lobbying Activities) 28
  Schedule D (Financial Statements) 28
  Schedule L (Transactions with Interested Persons) 25
  Schedule O (Supplemental Information) 29
  Schedule R (Related Organizations and Unrelated Partnership) 20
  Schedules
    completing 10
  schedules, checklist of required 26
  SETUP options, overriding 35
  short-form returns (Form 990-EZ) 12–13
  signature block 29
  statement
    see also financial statements
    of functional expenses 21
    of program service accomplishments 22
    of revenue 21
  summary
    on Form 990, Part I 26
    report printing 35
  supplemental information (Schedule O) 29
  Supplemental Information screens 10
  suppressing commas 35

T
  tax
    compliance statements (Part V of Form 990) 24
    excise, credit for 16
    liability, reporting 16
    year, specifying a 20
  transactions (Schedule L) 25
  type of form, selecting 19

U
  unrelated business income, reporting 16
  updating a prior-year return 10
V

volunteers 26